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Callahan Chapter 1.
- Page 1 (bullet at bottom): Launch Access 2007.

- Page 3, step 1: Since we're using Access 2007, you cannot create the file the book expects. Skip steps 1-9 here and open your C:\CIS217 Data
Files\Cdlahan\Contacts.mdb, which has the same objects as the file the Database Wizard would have created in Access 2002. Work carefully since you'll use this
samefilein Chapters 1-7. Continue at the top of page 4.

- Page5, step 1 at bottom: Press [F11] to open the database Navigation Pane.

- Page 6, step 3: Press [F11] to close the Navigation Pane.

- Page 8, step 1: I’ ve aready imported the 18 contacts for you. Skip ahead to step 1 in the middle of page 9.

- Page 10, step 1: Click Create | Report Wizard instead, then skip ahead to step 4.

- Page 11, step 10: Do as written but click Outline instead.

- Page 12, step 14: Press [F11] to close the Navigation Pane.

- Page 14, step 3 (lower occurrence): Access 2007 does not have a Toolbox. Use the Design tab’s Controls group instead.

. Page 18, step 2: Exit Access 2007 by clicking the Office Button ' | then click Exit Access. Now launch Windows Explorer and backup your Contacts.mdb file by
copying it to your USB flash drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 2.

- Page 21 (bottom of page): Open the Contacts database you used in Chapter 1. Since we'll be using the file from Chapter 1, instead of the author’s Ch02 Contacts
file, we will need to make some modifications as we go along, which are listed below. By using the same file in each chapter, we'll end up with onefile that contains
all of the functionality you’ ve studied.

- Page 38, step 12: Modify the controlsin the form footer to resemble theillustration on page 42. Notice the location of the Page label, and the 5 command buttons to
itsright. Drag them all to the left. Now, use choices on the Arrange tab to align and size the controls to resembl e the illustration.

- Page 43, step 2: Click the Office Button ™', then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 3.
- Page 45 (bottom of page): Open the Contacts database you used last chapter (instead of Ch03 Contacts).

- Page 46, step 1 (upper occurrence): Once your Contacts form opens compare it to the illustration. Since we're using the file we used in Chapter 2 (rather than the
author’s Ch03 Contacts), your Contacts form has the Add Record, Edit Record, and Save Record buttons. By using the same file in each chapter, we'll end upwith
onefile that contains al of the functionality you’ ve studied.

- Page 46, step 2 (upper occurrence): Notice the illustration shows the Contact ID field abovethe First Name field, but our form still hasit to the right of Last Name.
Oncein Design View simultaneously select all of the controls on the | eft side of your form (First Namethrough Country), then drag them al down so that the
bottom of First Nameis at ¥2". Now, move the Contact ID label and text box controls to the left so they appear above First Name Y our Contacts form should now
resemble the illustration at the bottom of page 46. Save your form.

- Page 48, step 4 (upper occurrence): Select Light Gray 2 (3" row, 1% column).

- Page 48 (near top of page) add new step 5: Since our Contacts form’s AllowEdits property is set to False (from Chapter 2), the form is read-only and the combo
box value cannot be changed. We need to allow edits before the combo box receives the focus and make the form read-only again as the combo box loses the focus.
The paragraphs below guide you through the necessary changes.

Remain in Design View. Select the new combo box and open the Property sheet. Click the Event tab | click On Enter | click the Build button
(...). When the VB window opens you' Il be placed in an event handler for the combo box’ s Enter event. Press Tab and type
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Me.AllowEdits= True.

Now, return to Access by clicking the Access button in the Windows Taskbar. In the Event tab | click On Exit | click the Build button (...).
You'll now bein an event handler for the combo box’s Exit event. Press Tab and type M e.AllowEdits = False. Close the VB Window. Click
the Save button. Close the Property sheet.

Resume on page 48 at Try Out the Combo Box.
- Page 48, step 4 (lower occurrence): RowSource is about halfway down the list of properties.

- Page 51, step 8: Since we' re working with the file from Chapter 2 the Form_Current event procedure will already contain the statement M e AllowEdits = False.
Add the new statement above the existing statement. Note: Be sure you use the actual name of your combo box (eg: Combo51).

- Page 53, step 1: Filter by Form is available on the Home tab's Sort and Filter group | click the Advanced button | click Filter by Form.
- Page 53, step 4: In Access 207 the button is named Toggle Filter, it is just below the Advanced button.

- Page 62: add new step 5 before Try the Option Group: Since our Contacts form’s AllowEdits property is set to False (from Chapter 2), the form is read-only and
the option group’s value cannot be changed. We need to allow edits before the option group frame receives the focus and must make the form read-only again as the
option group frame loses the focus. The paragraph below guides you through the necessary changes.

Whilein the FilterOptions_AfterUpdate() procedure, click the Proc list box in the upper right side of the VB window, then select Enter. You're
now in an event handler for the option group’s Enter event. Press Tab and type M e AllowEdits = True. Now, click the Proc list and select
Exit. You'll now bein an event handler for the option group’ s Exit event. Press Tab and type M e.AllowEdits = False.

Resume on page 62 at Try the Option Group.
- Page 63, step 2: In Access 2007 you need to click the Selection button | then click Equals “ Seattle”.

- Page 65, step 3: Click the Office Button ™, then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 4.
- Page 70, step 5: You won't need to click Code builder since we already have code in the combo box’ s Enter event.

- Page 71, step 6: Add the new line of code below the existing AllowEdits line.

- Page 72, step 2 (upper occurrence): We already have code in the combo box’ s Exit event. Add the new line of code below the existing AllowEdits line.
- Page 77, step 3: KeyPreview is at the bottom of the Event properties.

- Page 85, step 2: Click your Edit Record button first, and then do the step as written.

- Page 86, step 2: Click the Office Button ™, then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 5.
- Page 89 (bottom): Open your Contacts database Once it opens, close the Switchboard and press [F11] to open the Database Navigation Pane.

- Page 91, step 2: Click Create tab | in the Other group, click the Macro down arrow | click Module.
- Page 101, step 3: First click the Edit Record button, then do the step as written.

- Page 107, step 3: Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan folder.
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Callahan Chapter 6.
- Page 109 (bottom), open your Contacts database. Once it opens, close the Switchboard and press [F11] to open the Database Navigation Pane.

- Page 114, step 3: Right-click the Contacts form, click Design View, then click the Code button in the upper-right portion of the Ribbon’s Design tab. Once the
Visual Basic window opens, you' Il bein the Contact form’s Declarations section at the line that reads Option Compare Database. Below that line type Option
Explicit and press [Enter].

- Page 115, step 3: Click the Edit Record command button in the form footer before doing this step. Note: if the record’ s ZipCode has aready been deleted, enter a
new value, then deleteit right away, then continue to the next step.

- Page 126, step 3: Click the Add Record command button in the form footer instead.

- Page 129, add new step 6: Press [Shift]+[Enter] to attempt to save Fiona s record. Recall that you added a Validation Rule in chapter 4 that prevents both phone
numbers from being blank. Enter a\Work Phone of (555) 555-5555, then save the record.

- Page 129, add step 2: Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB
flash drive’s CIS217 Data Files\Callahan folder.

Callahan Chapter 7.
- Page 131 (bottom), open your Contacts database. Once it opens, close the Switchboard and press [F11] to open the Database Navigation Pane.

- Page 134, step 3: First click the Edit Record command button in the form footer, and then do the step.

- Page 137, add new step O: Recall that we' re using the Contacts database from chapters 1-6, which already has code to handle the ContactTypel D’s NotInList event.
Remove the existing code now by switching into Design View | click the Code button in the upper-right of the Ribbon’s Design tab | select ContactTypel D in the
Object list box in the top left of the code window | select NotInList in the Procedure list box in the top right of the code window | select and delete the 4 lines of code
for the entire ContactTypel D_NotInList event handler. Return to the Contacts form in Form view.

- Page 137, step 1: First click the Edit Record command button, then do the step.

- Page 140, step 3: Click the Edit Record command button, then do the step as written.

- Page 142, step 5: First click the Edit Record command button, then do the step.

- Page 145, step 5: First click the Edit Record command button, then do the step. Also, we' Il receive adightly different error message.

- Page 146, add new step 10: Change the Contacts form’'s Recordset property back to Dynaset by performing the following: Open Contacts formin Design view |
open the Properties sheet | select Data tab | change RecordsetType to Dynaset. Save and close the form.

- Page 147: Third paragraph from bottom: there is no On Error Goto Next statement; the author means On Error Resume Next.

- Page 147, step 2: Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Contacts.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 8.
- Page 150 (top): Open your C:\CIS217 Data Files\Callahan\Subscription.mdb. Y ou' Il use this database as you work through Chapters 8, 9, and 11.

- Page 153, step 1: Press [F11] to open the Database Navigation Pane, if necessary.

- Page 153, step 2: Click Create | Blank Form instead. Switch to Design View and close the Field List since a Dialog Box is an unbound form. Select the Arrange tab |
click the AutoFormat list arrow | apply the Access 2003 (row 1, col 1) auto format so the form will more closely resemble theillustration.

- Page 154, step 5: Do aswritten. Now, you'll see an extra Wizard step asking what Sort order you would like. Click Next a second time to ignore it and continue.

- Page 155, step 4: Do as written. Now select the list box and label controls and set their font size to 9. Then change the width and height of your form window to
resemble the figure at top of page 156. Save your desigh changes.
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- Page 163, step 1: Switch to Layout View instead.

- Page 164, steps5 & 6: Omit. Remain in Layout view and continue with step 7.

- Page 165, step 10: Omit. This property is not available in the property sheet in Access 2007.

- Page 166, step 4: Onceit isvisible, edit the record for Judy Doyle by changing her Paid Through date to the first day of next month.

- Page 166, step 6: onceit isvisible, edit the record for Gilbert Greenman by changing his Paid Through date to two months from the current date.
- Page 168, step 2 (bottom occurrence): Right-click the report, then click Design View.

- Page 169, step 3: Indent the lines when typing the code for each Case in the Select Case statement.

- Page 173, add new step 7: Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Subscription.mdb file by copying it to your
USB flash drive's CIS217 Data Files\Callahan folder.

Callahan Chapter 9.
- Page 175 (bottom): Continue working with your Subscription database from Chapter 8.

- Page 177, step 1. Press [F11] to open the Database Navigation Pane, if necessary.
- Page 178 (middle), step 1: Right-click the Subscribers form, and then click Design View.
- Page 180 (bottom), step 2: Click the Form Selector button (where the horizontal and vertical rulersintersect) instead.

- Page 191, step 2: Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Subscription.mdb file by copying it to your USB flash
drive's CIS217 Data Files\Callahan fol der.

Callahan Chapter 11.
- Page 213: Open your Subscription.mdb file from Chapter 9.

- Page 216, add new step 10: Since the Switchboard is an unbound form, it does not support the Dirty property. We need to change the code created to handle the
QuitApplication command button’s Click event. Click the View Code button. Scroll until you can seethePri vat e Sub Quit Application_Cick
procedure. Deletethelinethat reads| f Me.Dirty Then Me.Dirty = Fal se.

- Page 216 (bottom), step 1: Click the Form Selector button (where the horizontal and vertical rulersintersect) instead.
- Page 217, step 2: Do as written but remember that we skipped Tutorial 10 so we don’'t have a custom Ribbon or custom toolbar.

- Page 218 (top), step 1: Startup options have been moved in Access 2007. Click the Office Button ™' | select Access Options | click Current Database | in the
Application Options section, click the Display Form list arrow and select Switchboard. Keep this Access Options dialog box open as you continue to the next step.

- Page 219, step 2: Scroll down to the Navigation section, then clear the Display Navigation Pane check mark.

- Page 219, step 3: Omit this step.

- Page 220 (middle): User Level Security has been removed in Access 2007.

- Page 221, step 1: In Access 2007 launch the Database Splitter by clicking Database Toolstab | in the Move Data group, click Access Database.

- Page 222, step 3: Place your backend database in C:\CIS217 Data Files\Callahan.

- Page 223, step 1: Right-click the Switchboard form, click Design View, click the View Code button in the upper-right portion of the Ribbon’s Design tab.
- Page 226, step 3: Rename Subscription-yournamehere_be.mdb to Subscription Data-yournamehere.mdb.

- Page 227, add new step 7: Exit Access. Launch Windows Explorer and backup your Subscription.mdb and Subscription Data.mdb files by copying them to your
USB flash drive’s CIS217 Data Files\Callahan folder.
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Callahan Chapter 12.
- Page 230 (top): Open your C:\CIS217 Data Files\Callahan\l ssues.mdb. Y ou'll use this database as you work through Chapters 12, 13 (extra credit) and 15.

- Page 231, step 1: Press [F11] to open the Database Navigation Pane.

- Page 235, step 3: It may be easier to click one of the upper itemsin the Classes list, then press [D] to scroll to the D’s, then scroll down a bit to DoCmd.
- Page 236, step 3: The contents of the Access 2007 help topic will be somewhat different.

- Page 241 (bottom), step 1: Since our file doesn’t expose the custom menu bar, use the Navigation Pane to open the Reassigner form.

- Page 253, step 2: Click the Office Button, and then click Exit Access. Then launch Windows Explorer and backup your Issues.mdb file by copying it to your USB
flash drive’ s CIS217 Data Files\Callahan folder.

Callahan Chapter 13. (Optional, Extra Credit, due before end of Finals week.)
- Page 255 (bottom): Open your Issues.mdb file. Close the startup form, then press [F11] to open the Navigation Pane.

- Page 269, add new step 5: Omit the rest of the chapter. Click the Office Button, then click Exit Access. Launch Windows Explorer and backup your Issues.mdb file
by copying it to your USB flash drive’s CIS217 Data Files\Callahan folder.

Callahan Chapter 15.

- Note: We will work only with the portions of the chapter that deal with hyperlinks on bound forms. We'll skip custom menu commands (which are sufficiently
different in Access 2007) and Data Access Pages (since they’ ve been deprecated in Access 2007). Regarding the Important note— you'll be fine provided you have
Internet access and an installed web browser.

- Page 291 (bottom): Open your Issues.mdb file. Close the startup form, then press [F11] to open the Navigation Pane.
- Page 293, step 3: Insert Hyperlink is on the Design tab, in the Controls group.
- Page 297, step 6: Do the step as written, then skip ahead to page 301 and resume at Modifying Hyperlinks Using Visual Basic.

- Page 304, add new step 7 (bottom of page): Omit the rest of the chapter (since Data Access Pages are not available in Access 2007). Click the Office Button, then
click Exit Access. Launch Windows Explorer and backup your Issues.mdb file by copying it to your USB flash drive's CIS217 Data Files\Callahan folder.




